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1. Getting Started 
PartsManager Pro is a CD/DVD-based application that allows you to find parts and 
service information and bulletins for multiple OEMs quickly and easily. Organize your 
work by jobs, create a picklist for each job, and prepare quotes for your customers. Add 
your own notes to part numbers and parts pages. Print parts diagrams, parts lists, user 
notes, OEM notes, picklists, and quotes. Configure the interface to your business 
system. Set up ProQuest eConnect ordering so you can view real-time inventory 
information from your suppliers and place orders. 

 

 

PartsManager Pro at a Glance 

 Create jobs to organize your transactions. 

 Search for parts and service information and 
bulletins. 

 Navigate to parts pages. 

 Create a picklist for each job. 

 Prepare quotes for your customers. 

 Create user notes and view OEM notes. 

 Print parts pages, notes, picklists, quotes, and 
other information. 

 Bookmark parts pages you use frequently. 

 Set up connections to your business system 
and eConnect. 

 View real-time inventory information and place 
orders. 
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Opening PartsManager Pro 
Use either of these procedures to open the application. 

Use the Desktop icon: 

1. Double-click the application icon from the Windows®
 desktop. 

 

2. The Main Page of the application is displayed. 

Use the Windows menus: 

1. Click Start. 

2. Select Programs. 

3. Select PartsManager Pro. 

4. Select PartsManagerPro  

5. The application opens to the Main Page. 
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Arranging the Application Windows 
You can move each application window to any position on the screen. You can also 
keep the windows open at the same time, arranged as you want. Most windows are 
resizable. Once you arrange and size the windows the way you want, they will remain in 
those positions each time you open the application. 

 

Switching Between Application Windows 
With a single click, the PartsManager Pro button bar allows you to display the Main 
Page, Navigation window, Search dialog box, or Picklist dialog box. These four buttons 
are displayed in the Navigation window, Search dialog box, and Picklist dialog box. 

Note: You can also use the Windows task bar to switch between application windows. 

 

 

 

 

Main Page displaying 
a parts page (parts 

diagram and parts list)

Search  
dialog box 

Navigation 
window 

Picklist 
dialog box 

Click to display 
the Main Page. 

Click to display the 
Navigation window.

Click to display the 
Search dialog box. 

Click to display the 
Picklist dialog box. 
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Using the Main Page 
The Main Page is your starting point in the application. 

 

 

 

 

 

 

Feature  How to Use 

Pull-down menus  Use the pull-down menus to work with jobs, change settings, bookmark 
frequently used parts pages, and display application Help. 

History list box  Use the History list box to return to a previously viewed parts page in a job. 

Page list box  The Page list box displays the title of the current parts page and allows 
you to select a different page. 

Job Tabs  Use the job tabs to switch between open jobs. 

Job list box  Use the Job list box to type a name for a new job or select an existing job. 

 
 Click the New Job icon to create a new job. 

 
 Click the Navigation button to navigate to parts pages. 

 
 Click the Search button to search for parts and service information.  

 
 Click the Picklist button to open a picklist. 

 
 Click the Print button when a parts page is displayed to print the parts 

diagram, parts list, page notes, and part notes. 

 
 Click the Alpha Index button to switch between an alpha index and a 

parts list. 

 

 To identify a button, icon, text box, column header, etc., position the 
mouse pointer over the feature to display its label or a brief explanation 
of how to use it (referred to as a ToolTip). 

 

New Job 
icon 

Job 
list boxJob tabs 

Pull-down 
menus 

History 
list box 

Alpha Index 
button 

Page list 
box 

Navigation button 

Search button 

Picklist button 

Print button 
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Using the Pull-Down Menus 
The pull-down menus allow you to work with jobs, print, set up the application interface, 
bookmark your favorite parts pages, and view the user guide, Help, and tutorial. To use 
a pull-down menu, click a menu name on the menu bar. The menu drops down to show 
the available commands. Then select a command. 

File Menu 
Click File on the menu bar and select a command to create, open, close, and print jobs 
and to close PartsManager Pro. 

New Creates a new job, assigning the date and time 
as the default name. You can rename the job in 
the Job Manager. 

Open Opens the Job Manager. 

Close Closes the current job. 

Close All Closes all open jobs. 

Print Opens the Printing dialog box, from which you 
can print the parts diagram, parts list, page 
notes, part notes, picklist, or an entire section. 
The Print command is available only when a 
parts page is displayed. 

 

Exit Closes PartsManager Pro. 
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Tools Menu 
Click Tools on the menu bar and select a command to change application settings, open 
the Job Manager, and configure your business system interface (BSI) or subscribe to 
eConnect. 

Settings Opens the Settings dialog box, from which you 
can select options that determine how the 
application displays parts and service information.

Job Manager Opens the Job Manager dialog box, from which 
you can open, rename, and delete jobs. 

 Part 
Integration 

Opens the Part Integration dialog box, from 
which you can configure a business system 
interface or subscribe to eConnect and set up 
your trade partners (vendors). 

 Dealer 
Information 

Opens the Dealer Information window, in which 
you can type dealer information for quotes and 
eConnect orders. 

 Price Books Opens the Price Books dialog box, from which 
you can import price files into PartsManager Pro. 

Note: This feature is only available for OEMs 
whose price files are in a particular format. 
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Favorites Menu 
Click Favorites on the menu bar and select a command to bookmark your favorite parts 
pages, that is, pages you frequently use. 

Add to Favorites Opens the Favorites window, from 
which you can bookmark a parts 
page as a favorite. 

 

Organize Favorites Opens the Organize Favorites 
window, from which you can 
organize your favorites in folders. 

The individual favorites and the favorite folders you create are listed in the bottom 
portion of the menu. When you select a favorite, the application immediately takes you to 
the corresponding parts page. Clicking a folder opens a list of favorites saved in the 
folder. Clicking a favorite in the folder displays the corresponding parts page. 
 

Help Menu 
Click Help on the menu bar and select a command to display the online Help, user’s 
guide, and interactive tutorial. 

Help Displays the PartsManager Pro 
online Help. 

User Guide Displays this user’s guide as a PDF 
in Adobe® Reader®. 

Tutorial Displays the PartsManager Pro 
interactive tutorial. 

 

About Displays the application and dataset 
versions. 
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Changing Settings 
PartsManager Pro allows you to set options that determine how the application displays 
parts and service information. Select Settings from the Tools menu. The Settings dialog 
box is displayed. Click the General tab, Page tab, or Job tab, or Search tab, select the 
appropriate options, and click OK. 

  
 

Option  How to Use 

Display Navigation  Select this option to display the Navigation window with the Main Page 
when you open the application. Close and reopen the application to see the
change. Move the window to a convenient position. It will remain in that
position each time you open the application. 

Display Search  Select this option to display the Search dialog box with the Main Page when
you open the application. Close and reopen the application to see the
change. Move the window to a convenient position. It will remain in that
position each time you open the application. 

Display None  Select this option to display only the Main Page when you open the 
application. 

Currency  Select the currency in which prices are displayed. See chapter 17, “ISO 
4217 Currency Codes”, to find the applicable code. 

Application Language  Select the language in which application interface text is displayed. 

Data Language  Select the language in which OEM data is displayed. When no data is
available from the OEM in the selected language, English data is displayed.

Image on the left  Select this option to display the parts diagram to the left of the parts list
on a parts page. 

Image on the top  Select this option to display the parts diagram above the parts list on a
parts page. 

Word Wrap  Select this option to make text in a parts list adjust so that the text is 
viewable horizontally. This eliminates the need to use the horizontal
scroll bar. 

Note: If you do not want text to wrap in all parts lists, do not select this
option. You can temporarily wrap text in any parts list by right-clicking the 
parts list and selecting Word Wrap from the context menu. 
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Option  How to Use 

Automatically delete 
old jobs 

 Select this option to automatically delete all jobs that are older than a
specified number days. To change the number of days from 45 to 
another number, select the option, click in the “Days old or older” box,
and type a different number. 

PartsManager Pro will continually monitor your jobs, delete each job 
when it reaches the limit you specify, and refresh the list of jobs in the
Job Manager. 

Must type in wildcards  Select this option if you want to type wildcards for partial part number
searches and partial description searches. For example, typing *lock*
will search for all part descriptions containing the word “lock”. Typing 
lock will only search for the exact description “lock”. * 

Wildcards assumed  Select this option if you do not want to type wildcards for partial part
number searches and partial description searches. For example, typing
lock will search for all part descriptions containing the word “lock” in 
addition to the exact description “lock”. * 

Show First Page  Select this option to make a keyword search automatically display the
first parts page in the selected catalog. 

Show Alpha Index  Select this option to make a keyword search automatically display the 
alpha index for the selected catalog. 

Show First Page 
Show Alpha Index 

 Select both options to make a keyword search automatically display the
first parts page in the selected catalog, then display the alpha index on 
top of the parts list. 

Collapse Navigation  Select this option to make a keyword search close the navigation tree
when it displays your search results 

 

* For information on using wildcards in searches, see “Using Wildcards” in chapter 3. 
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Entering Dealer Information 
You only need to enter your dealership information one time. After you type this 
information, it will be applied automatically to each quote or eConnect order you create. 
If any information changes, you can modify it at any time. 

1. Select Dealer Information from the Tools menu to open the Dealer Information 
window. 

 

2. Type information in the text boxes and click OK. 

The information you type will appear automatically on your quotes and eConnect orders. 
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2. Working with Jobs 
As you use PartsManager Pro, you will work with “jobs”. A job is another name for a 
transaction, a collection of related tasks you perform to process a parts order. 

As you accumulate parts on a picklist, they are associated with a new or existing job. 
The Job Manager allows you to name and organize jobs for easy access. 

When you create a job, a “tab” is created for that job. You can have multiple jobs open at 
a time, each identified by name on a tab. Switching between open jobs is as easy as 
clicking a tab name. This feature can be very useful when you need to work on more 
than one transaction at a time. 

For example, while working on a job for customer A, customer B calls to place a new 
order. You open a new job, name it for customer B’s account, and set up a picklist of 
parts for that order. As you are finishing that job, you receive a call from customer C 
inquiring about parts from an existing order. You locate that job in the Job Manager, 
open it, and quickly answer customer C’s question. 

To handle these three situations, you had three jobs open simultaneously and were able 
to switch between them quickly as needed. The PartsManager Pro application allows 
you to keep as many as seven jobs open at a time. 

Note: On Windows 98 PCs, you can keep two jobs open at a time. 

In addition, the History list box allows you to quickly redisplay parts pages that you 
viewed previously for each job. 

 

Jobs at a Glance 

 A separate tab is created for each job that you start. 

 You can open stored jobs from the Job Manager or the 
Job list box. 

 When you open a job, the parts page most recently 
viewed in that job is displayed. 

 You can have a maximum of seven jobs open at the 
same time. (Windows 98: Two jobs) 

 You can switch between jobs as necessary. 
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Managing Jobs 
The Job Manager lists all jobs stored in the system and allows you to rename, open, and 
delete jobs. 

Opening and Using the Job Manager 
To open the Job Manager, select Job Manager from the Tools Menu. 

 

 

Feature  How to Use 

       
 Indicates that a job is open and cannot be accessed by users from other 

computers. 

Job Name  The job name can be (1) the default name assigned by the application, 
which consists of the date and time the job was created, or (2) a name 
typed by the user who created the job. 

Last Modified  Shows the date indicates on which changes were most recently made to a 
job. 

Open  Opens the highlighted job. 

Rename  Allows you to rename the highlighted job. 

Delete  Deletes the highlighted job. 

Close  Closes the Job Manager. 
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Opening a Job from the Job Manager 
1. Select Job Manager from the Tools Menu to open the Job Manager dialog box. 

2. Click the job name to highlight it. 

3. Click Open. 

Note: You can also open a job from the Job Manager by double-clicking a job name. 

Renaming a Job from the Job Manager 
1. Select Job Manager from the Tools Menu to open the Job Manager dialog box. 

2. Click the job name to highlight it. 

3. Click Rename to open the Rename dialog box. 

 

4. Type a new name in the text box. 

5. Click OK. The job name changes in the Job Manager and the tab displays the new 
name you typed. 

Deleting a Job from the Job Manager 
1. Select Job Manager from the Tools Menu to open the Job Manager dialog box. 

2. Click the job name to highlight it. 

3. Click Delete. The job is deleted from the system, the job no longer appears in the 
Job Manager, and no tab for the job is displayed. 

4. To delete multiple jobs at the same time, hold down the Ctrl key and click each job 
you want to delete. The selected jobs are highlighted. Then click Delete. 

Note: For information on setting up PartsManager Pro to automatically delete jobs 
older than a specified number of days, see “Changing Settings” in chapter 1. 
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Rearranging Information in the Job Manager 
PartsManager Pro allows you to change the order in which jobs are listed and to resize 
and move columns. 

Sorting Information 

If you develop a naming convention for jobs, you can use sorting to arrange jobs by 
name, making it faster and easier to locate a job. Change the order in which part entries 
are listed by doing the following: 

Click a column header. Entries are listed in order according to the information in that 
column. An upward-pointing triangle appears on the right side of the header and 
information is arranged in order from first to last. That is, entries that begin with letters 
are arranged in A-Z order and entries that begin with numbers are arranged in 1-9 order. 

If you click the column header again, a downward-pointing triangle appears on the right 
side of the header and information is arranged in order from last to first. That is, entries 
that begin with letters are arranged in Z-A order and entries that begin with numbers are 
arranged in 9-1 order. 

Resizing Columns 

Resize column widths by doing the following: 

1. Place the mouse pointer on the boundary between two column headers. The mouse 
pointer changes to . 

2. Hold down the left mouse button. 

3. Drag to the left or right. 

Moving Columns 

Rearrange the order in which columns appear by doing the following: 

1. Place the mouse pointer on a column header. 

2. Hold down the left mouse button and drag the header to the left. 

3. Stop dragging where you want to insert the column. A small green arrow indicates 
where the column will be inserted. 

 

4. Release the mouse button. The column is inserted at the arrow. 
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Additional Ways to Work with Jobs 

Starting a New Job 
1. Click in the Job list box to insert the cursor. 

2. Type a job name. 

Note: When you click  without typing a name, the application 
assigns a date/time name to the new tab. 

3. Click . A new tab is created, labeled with the name you typed. 

Opening a Job from the Job List Box 
1. Click the Job list box arrow to open a list of jobs. 

2. Select a job. 

3. The job opens on a tab. 

Opening a Job from the File Menu 
1. Select Open from the File Menu. 

2. The Job Manager is displayed. 

3. Do one of the following: 

• Click the job name to highlight it and click Open. 

• Double-click the job name. 

Closing a Job Using a Context Menu 
1. Right-click the appropriate job tab to open a context menu. 

2. Select Close. 

Closing Jobs Using the File Menu 
To close the current job, select Close from the File menu. 

To close all open jobs, select Close All from the File menu. 
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Renaming a Job Using a Context Menu 
1. Right-click the job tab to open a context menu. 

2. Select Rename to open the Rename dialog box. 

3. Type a new name in the text box. 

4. Click OK. The tab displays the new name you typed. 

Deleting a Job Using a Context Menu 
1. Right-click the job tab to open a context menu. 

2. Select Delete. The job and its tab are deleted. 

Displaying Previously Viewed Parts Pages for a Job 
The History list box displays the current parts page in the active job and keeps a record 
of pages you view. When you have multiple jobs open at a time, the History list box lists 
the previously viewed parts pages for each job. When you click a job tab, the History list 
changes to the pages viewed for that job. 

 

When you open an existing job, the History list box lists the last 10 pages viewed for that 
job. If you close and reopen PartsManager Pro, the History list box lists the last 10 
pages you viewed for each job. 

To display a previously viewed parts page, click the appropriate entry in the list box. 
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3. Searching for Information 
This chapter provides guidelines to help you perform a search within a catalog. You can 
search for parts information, parts pages, service information, and bulletins. 

 

 

 

Searches at a Glance 

 Click a tab to select the type of search. 

 Type keywords defined by your OEM. 

 Search by part number, description, and 
remarks text. 

 Use wildcards to make searches easier. 

 Search the price file. 

 Search for parts pages, service information, 
and bulletins. 

 Group and sort your search results. 
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Typing Keywords and Models 
As you type a keyword from the Keyword tab or a model from the Parts tab, the list of 
available keywords or models automatically scrolls to the first available selection. 

This feature allows you to enter a keyword or model more quickly. It also allows you to 
see available keywords. 

1. When you open the Search dialog box, the first selection is displayed. For example: 

 

2. Type h. A list box opens and scrolls to the first selection that begins with the letter “h”. 

 

3. Type hm. The list box scrolls to the first selection that begins with the letters “hm”. 

 

4. Type hms. The list box scrolls to the first selection that begins with the letters “hms”. 

 

5. Continue typing until you display the keyword or model you need. 
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Searching by Keyword 
A keyword search allows you to search for a catalog by typing a model or other keyword. 
A keyword is defined by your OEM. 

1. Click  to open the Search dialog box. 

2. Click the Keyword tab. 

3. Select an OEM from the list box. 

4. Type a keyword in the Search For text box. 

 

 

5. Click the Search button  to display a list of catalogs that match your keyword. 

 
 
 

 

The Keyword column displays 
the keyword associated with 
each  catalog.
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6. Double-click a catalog from the Catalog pane to display the catalog title and parts 
pages in the Navigation pane. 

 

If “Collapse Navigation” is selected in the Search tab of the Settings dialog box, the 
navigation tree will be closed. To open the navigation tree, click . 

Note: You can right-click a catalog in the Navigation pane to compare model 
specifications. When a Catalog Note icon appears on a folder, you can also view 
catalog notes. See “Viewing Catalog Notes” and “Comparing Model Specifications” in 
chapter 4 for the procedures. 

7. PartsManager Pro automatically displays the first parts page in the catalog or the 
alpha index, depending on the Keyword Search option(s) you selected in the 
Settings dialog box. 

8. To display a different page, click a parts page title in the Navigation pane. 

Note: For information on the keyword search “Show First Page”, “Show Alpha Index”, 
and “Collapse Navigation” settings, see “Changing Settings” in chapter 1. 

Navigation pane
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Searching for Parts Information 
You can search for parts information by part number, part description, and remarks text 
to display a parts page. You can also find prices for parts included in the price file and 
search for all occurrences of a part number. 

Using Wildcards 
Note: To use wildcards, the option “Must type in wildcards” must be selected in the 
Search tab of the Settings dialog box. 

PartsManager Pro allows you to type wildcards in your search criteria for part number 
searches and part description searches. 

A wildcard is a special character that represents any other character or group of 
characters in a search. PartsManager Pro uses the asterisk (*) for the wildcard 
character. The asterisk (*) can represent zero, one, or multiple characters in a part 
number or description. 

Note: You cannot use wildcards with Price, Where Used, or Remarks searches. 

Using Wildcards in Part Number Searches 

Type a partial part number with the wildcard character (*). You can type wildcards at the 
beginning, middle, or end of a number. You can also use more than one wildcard with a 
number. The following are examples of part number searches using wildcards: 

0201*        *4200        02014*00        02*4*00 

For example, typing 0201* tells PartsManager Pro to find all part numbers that begin 
with “0201”, followed by any number of additional characters. Results could include the 
following: 020185, 0201000007, 0201-104500, 0201AB72 

Using Wildcards in Part Description Searches 

Type a partial description with the wildcard character (*). You can type wildcards at the 
beginning, middle, or end of a word. You can also use more than one wildcard. The 
following are examples of description searches using wildcards: 

loc*        lock*        *lock        *lock*        s*loc* 

For example, typing *lock* tells PartsManager Pro to find all part descriptions that 
contain the word “lock”. Results could include the following: lock nut, lock washer, 
locking collar, spring locking pin 
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Setting Wildcard Options 

The Search tab of the Settings dialog box allows you to set how wildcards affect partial 
part number searches and partial description searches. Select Settings from the Tools 
menu and click the Search tab. 

Select the option Must type in wildcards if you want to type wildcards for partial part 
number searches and partial description searches. For example, typing *lock* will 
search for all part descriptions containing the word “lock”. Typing lock will only search 
for the exact description “lock”. 

Select the option Wildcards assumed if you do not want to type wildcards for partial 
part number searches and partial description searches. For example, typing lock will 
search for all part descriptions containing the word “lock” in addition to the exact 
description “bolt”. 
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Searching by Part Number 
Use a part number search to list parts pages that contain a part number you specify. 

1. Click  to open the Search dialog box. 

2. Click the Parts tab. 

3. Select an OEM from the list box. 

4. To narrow your search, select a model. 

5. Type a part number in the Search For text box. 

Note: You can also type a partial part number with one or more wildcard characters (*). 
See “Using Wildcards” earlier in this chapter for details. 

6. Select the Part Number radio button. 

Note: Be sure that your selection applies to the text you typed in the Search For text box. 
With the Part Number radio button selected, a part number must appear in the text box. 

7. Click the Search button  to display a list of parts pages that contain the number 
you typed. 

 

 

8. Double-click an entry to display the parts page. 

Search button 
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Searching for Prices 
A price search allows you to find the price of any part number included in the price file. A 
price search does not lead to a parts page. The Price File button is only available for part 
number searches. You cannot type partial part numbers or use wildcards in a price search. 

1. Click  to open the Search dialog box. 

2. Click the Parts tab. 

3. Select an OEM. 

4. Type a part number in the Search For text box. 

5. Select the Part Number radio button. 

6. Click the Price File button  to display pricing information. 

 

 

7. To view additional information for a part number in your search results, right-click the 
part entry to display a context menu and select More Information. 

Price File button
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Making a “Where Used” Search 
Use this procedure to find all parts pages for all models in all catalogs that include the 
part number you type. You cannot type partial part numbers or use wildcards in a Where 
Used search. 

1. Click  to open the Search dialog box. 

2. Click the Parts tab. 

3. Select an OEM from the list box. 

4. To narrow your search, select a model. 

5. Type a part number in the Search For text box. 

6. Select the Part Number radio button. 

7. Click the Where Used button  to list all applicable parts pages. 

 

 

8. Double-click an entry to display the parts page. 

Where Used button 
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Searching by Part Description 
Use a part description search to display a list of parts pages that contain one or more 
words that you specify from part descriptions. 

1. Click  to open the Search dialog box. 

2. Click the Parts tab. 

3. Select an OEM from the list box. 

4. To narrow your search, select a model. 

5. In the Search For text box, type a part description. 

Note: You can also type a partial description with one or more wildcard characters (*). 
See “Using Wildcards” earlier in this chapter for details. 

6. Select the Part Description radio button. 

Note: Be sure that your selection applies to the text you typed in the Search For text 
box. With the Part Description radio button selected, text from a part description must 
appear in the text box. 

7. Click the Search button  to display a list of parts pages that contain the word(s) 
you typed. 

 

8. Double-click an entry to display the parts page. 
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Searching by Remarks Text 
Use a remarks text search to display a list of parts pages that contain Remarks column 
text that you specify. 

1. Click  to open the Search dialog box. 

2. Click the Parts tab. 

3. Select an OEM from the list box. 

4. To narrow your search, select a model. 

5. In the Search For text box, type one or more words from the Remarks column. 

6. Select the Remarks radio button. 

Note: Be sure that your selection  applies to the text you typed in the Search For text 
box. With the Remarks radio button selected, text from the Remarks column must 
appear in the text box. 

7. Click the Search button  to display all available matches for the word(s) you typed. 

8. Double-click an entry to display the parts page. 
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Searching for Parts Pages 
1. Click  to open the Search dialog box. 

2. Click the Pages tab. 

 

3. Select an OEM from the list box. 

4. To narrow your search, select a model. 

5. Enter your search criteria by typing either or both of the following: 

• Type one or more words from a page title in the Page Title text box. 

• Type a figure number or partial figure number in the Figure Number text box. 

6. Click the Search button  to display a list of parts pages that match your search criteria. 
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Searching for Service Information 
1. Click  to open the Search dialog box. 

2. Click the Service tab. 

 

3. Select an OEM from the list box. 

4. Type your search criteria in the Search For text box. 

5. Click the Search button  to display a list of documents that match your search criteria. 
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Searching for Bulletins 

Displaying Bulletins 
1. Click  to open the Search dialog box. 

2. Click the Bulletins tab. 

 

3. Select an OEM from the list box. 

4. Type your search criteria. (Bulletin search options are listed below.) 

5. Click the Search button  to display a list of bulletins that match your search criteria. 

Bulletin Search Options: 

Option #1: In the Search For text box, type one or more words from a bulletin title. 

Option #2: In the Part Number text box, type the part number to which the bulletin is 
attached. 

Option #3: In the Search For text box, type one or more words from a bulletin title and 
narrow your search by typing a range of bulletin release dates in the Start Date and End 
Date text boxes. When you type dates, you must type something in the Search For text 
box, even if it is only the * character. Type dates in the format yyyy-mm-dd (2005-04-25). 

Option #4: In the Search For text box, type the wildcard character (*) and type a range 
of bulletin release dates in the Start Date and End Date text boxes. When you type start 
and end dates, you must type something in the Search For text box, even if it is only the 
* character. Type dates in the format yyyy-mm-dd (2005-04-25). 
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Working with Bulletins 

If the bulletin opens in the PartsManager Pro main frame: 

 Right-click the bulletin to open a context menu and select 
a command to zoom, resize, or print the bulletin. 

 

 You can also double-click a bulletin to zoom in. 

 Multi-page bulletins display paging buttons in the upper left corner 
of the bulletin display. Click the buttons to page forward and back. 

 

 

If the bulletin opens in a separate Adobe Reader window: 

 Use the Adobe Reader features to zoom, resize, page, and print. 
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Rearranging Search Results 
PartsManager Pro allows you to group and sort information, resize columns, and change 
the column order. When you retrieve a large number of search results, you can scroll to 
the parts page title you want. But you may want to rearrange the results first. 

Grouping Search Results 
Grouping allows you to sort search results by one or more column headers. For 
example, you can group by part number or a combination of part number and page title. 

Example #1: Group Search Results by Part Number 

To group search results by part number, do the following: 

1. Place the mouse pointer on the Part Number column header, hold down the left 
mouse button, and drag the header to “Drag a column header here to group by that 
column”. An arrow indicates where the column header will be located. 

 

2. Release the mouse button. The search results are sorted by part number. 

 

3. Scroll to the part number you are looking for and click the plus sign (+) in front of 
“Part Number”. Parts pages that include that part number are listed. 

 

4. Double-click an entry to display the parts page. 
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Example #2: Group by Part Number and Page Title 

After grouping search results by part number, you may need to group the results again. 
To further group the results by page title, do the following: 

1. With the search results grouped by part number, place the mouse pointer on the 
Page Title column header, hold down the left mouse button, and drag the header to 
“Drag a column header here to group by that column”. An arrow indicates where the 
column header will be located. 

 

2. Release the mouse button to place the header next to the Part Number header. 

 

3. Scroll to the part number you want and click the plus sign (+) in front of “Part 
Number”. Then scroll to the page title you want and click the plus sign (+) in front of 
“Page Title”. Results that include that page title will be listed. 

4. Double-click an entry to display the parts page. 
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Resizing Columns 
Resize column widths by doing the following: 

1. Place the mouse pointer on the boundary between two column headers. The mouse 
pointer changes to . 

2. Hold down the left mouse button. 

3. Drag to the left or right. 

Moving Columns 
Rearrange the order in which columns appear by doing the following: 

1. Place the mouse pointer on a column header. 

2. Hold down the left mouse button and drag the header to the left. 

3. Stop dragging where you want to insert the column. The following example shows 
the Page Title column being inserted immediately after the Part Number column. An 
arrow indicates where the column will be inserted. 

 

4. Release the mouse button. The column is inserted at the arrow. In this example, the 
Page Title column is now located between the Part Number and Part Description 
columns. 
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4. Navigating to Parts Information 
Use the Navigation window to navigate to parts pages, view catalog notes, and compare 
model specifications (if your OEM data includes catalog notes and model specifications). 

Using Basic Navigation 
1. Click  to open the Navigation window. 

2. Click  preceding each level of catalog information you want to open. 

3. As additional levels of information are displayed, click  preceding each level you 
want to open. 

 

4. When you reach the final navigation level, that is, entries that are not preceded by , 
click an entry to open the corresponding parts page. 

Note: You can also use the keyboard arrow keys to navigate. Use  and  to move 
between  levels. Use  and  to open and close a level. 

Note: Click  to go up one navigation level. Or click  to close all navigation levels. 
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Viewing Catalog Notes 
When a catalog-level folder displays a Catalog Note icon , catalog notes are available. 
If your OEM data supports catalog notes, use this procedure to view available notes. 

Note: This feature is also available from the Navigation pane of the Search dialog box. 

1. Right-click the model specification or catalog to open a context menu. Select View Notes. 

 

2. The top portion of the View a Note window displays the initial text of each note. 

 

3. Click an entry to view the complete note in the bottom portion of the window. 

Catalog note icon 
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Comparing Model Specifications 
If your OEM data supports model specification comparisons, use the Compare feature to 
compare one model specification with another or to list the parts that must be added 
and/or removed to change a particular specification to another. This features compares 
the parts that make up both specifications and lists the parts that are different in Add and 
Remove columns. 

If you need to supply a particular product that is out of stock, you can use this feature to 
“change” an in-stock product to the product you need to supply. You do this by typing the 
in-stock product number in the “Change” text box and typing the number you need in the 
“To” box. When you click the Search button, parts you need to add to or remove from 
the in-stock product to assemble the out-of-stock product are listed. 

You may need to compare several products until you find the one you want. 

Note: This feature is also available from the Navigation pane of the Search dialog box. 

To compare or change model specifications: 

1. Right-click a model specification to open a context menu. Select Compare. 
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2. The Compare dialog box displays the model specification you selected under “Change”. 

 

3. From the “Into” text box, select the model specification you want to compare. 

 

4. Click Search. The dialog box lists the parts that are different in the Add and Remove columns.  

 

5. To print the list of parts to add and remove, click the Print button. 

6. When you finish viewing parts information, click Close. 

The model specification 
you selected appears in 
the Change list box.

Select the model 
specification you 
want to compare. 
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5. Using Pictorial and Alpha Indexes 

Using Pictorial Indexes 
If your OEM data supports pictorial indexes, use the following procedure to display 
information from the indexes. 

1. Navigate to a catalog that includes a pictorial index. 

2. Use the scroll bar to scroll to the catalog title. 

3. Click the catalog title (A) to display the primary pictorial index. 

 

 

 

 

 

A 

To adjust the width of the pictorial index window:
(1) Place the mouse pointer on the bar that 
separates the navigation tree from the pictorial 
index. The pointer changes to a double arrow. 
(2)  Hold down the left mouse button and drag 
the bar to the left or right to resize the window. 
The index will retain the width you set until you 
close the window. 
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4. Click the section title (B) to display the section pictorial index. 

 

5. Click a parts page title (C) or click a callout (D) from the index. 

6. The parts page (E) is displayed. 

 

B 

C 

D

E 
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To identify pictorial index callouts: 

To identify a callout, hold the mouse pointer on the callout. The pointer changes to a 
pointing hand . A label (F) corresponding to the entry in the left pane (G) will be 
displayed. For example: 

 

 

 

 

 

G 

F 

The label identifies the entry to 
which the callout corresponds. 
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Using Alpha Indexes 
If your OEM data supports alpha indexes, use the following procedure to display 
information from the indexes. 

1. Open a catalog using the Search dialog box or Navigation window. 

2. Click the first introduction page or parts page title to open the page. 

3. Click the Alpha Index button (A) to display the alpha index (B). 

 

B

A 
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4. Type the first few letters (C) of the item you are searching for. As you type, entries 
are highlighted (D) and the parts diagram (E) is displayed for the highlighted item. 

 

Note: You cannot select parts from the diagram while the alpha index is displayed. 
Display the parts list (step 5) before attempting to select parts. 

C

D

E 
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5. When the appropriate parts diagram is displayed, click the Alpha Index button to 
display the parts list (F) for the diagram. 

 

Note: You can also double-click the highlighted entry or press the Enter key when 
the entry is highlighted to display the parts list. 

6. Select the parts you need for your picklist. 

F 
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6. Working with Parts Pages 
A parts page consists of a parts diagram and its associated parts list. 

 

 

Parts Pages at a Glance 

 Change the relative positions of the parts diagram and 
parts list by selecting Settings from the Tools menu. 

 Quickly display a different parts page by selecting it 
from the Page list box. 

 Quickly display a previously viewed parts page by 
selecting it from the History list box. 

 Display additional information for a page and catalog by 
right-clicking with the mouse. 

 When you click a callout in a parts diagram, a red 
square highlights the callout and the corresponding 
entry is highlighted in the parts list. 

 When you click an entry in the parts list, the entry is 
highlighted and a red square highlights the 
corresponding callout in the parts diagram. 

 Multi-page parts diagrams display paging buttons. Click 
the buttons to page forward and back.  

Parts list Parts 
diagram 

Page list boxHistory list box 
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Displaying Previously Viewed Parts Pages 
The History list box displays the current parts page in the active job and keeps a record 
of pages you view. When you have multiple jobs open at a time, the History list box lists 
the previously viewed parts pages for each job. When you click a job tab, the History list 
changes to the pages viewed for that job. 

 

When you open an existing job, the History list box lists the last 10 pages viewed for that 
job. If you close and reopen PartsManager Pro, the History list box lists the last 10 
pages you viewed for each job. 

To display a previously viewed parts page, click the appropriate entry in the list box. 

Switching Parts Pages 
The Page list box displays the title of the current parts page and allows you to switch to 
a different page. 

 

To switch to a different parts page, click the list box arrow to open the list. Then click a 
title or press the  and  keyboard keys to display a different parts page. 

When the last parts page in a section is selected, press the  key or the Page Down key to 
move to the next section of parts pages. When the first parts page in a section is selected, 
press the  key or the Page Up key to move to the previous section of parts pages. 
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Displaying Additional Information for a Page and 
Catalog 
Use this procedure to view additional information for the current parts page and catalog. 

1. Right-click the parts diagram to display a context menu. 

 

2. Select Page Info from the menu to display the Page Info window. 
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3. To view additional information for a catalog, click the Catalog Info button to display 
the Catalog Info window. 

 

4. When you finish viewing catalog information, click the Catalog Info Close button. 

5. When you finish viewing page information, click the Page info Close button. 
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Zooming, Resizing, and Printing Parts Diagrams 

Using the Context Menu 
Right-click in a parts diagram to display a context menu. Then select a menu command. 

 

Command  How to Use 

Zoom In  Zooms in on an area of the parts diagram. 

Zoom Out  Zooms out. 

Fit to Height  Resizes the parts diagram to fit the height of the display area. 

Fit to Width  Resizes the parts diagram to fit the width of the display area. 

Full Screen  Resizes the parts diagram to fill the entire diagram/parts list display 
area. When the diagram is maximized, this command changes to “Split 
Screen”. Selecting Split Screen restores the diagram to its default size. 

Refresh  Restores the parts diagram to its default size. 

Page Info  Displays additional information for a parts page. 

Print  Prints the parts diagram, including the parts page title and catalog title. 

Add a Note  Allows you to add a user note to the parts page. 

Add to Picklist  Adds a part to a picklist. 

Back  Not available at parts pages. 
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Using the Mouse Pointer to Zoom In on a Parts Diagram 
1. Place the mouse pointer above and to the left of the area you want to zoom in on. 

2. Hold down the Shift key. 

3. Hold down the left mouse button. 

4. Start dragging the mouse down and to the right. A red box appears. 

5. Keep dragging until the red box covers the area you want to magnify. 

 

6. Release the mouse button and Shift key to zoom in on that portion of the diagram. 
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Working with Parts Lists 
The parts list displays the parts corresponding to the callouts on the parts diagram and 
allows you to select parts for a picklist. 

Viewing Additional Information for a Part 
Use this procedure to view the part number, description, price, and supersession 
information (when available) for a part. If you have a BSI connection, you can also view 
such information as bin location and part availability. If you subscribe to eConnect, you 
can also view real-time inventory information from your trade partners (vendors). 

 
 

1. Right-click a part entry to display a 
context menu. 

2. Select More Information to display 
the More Information window. 

 

 

Note: You can also highlight an entry and press the space bar to open a context menu. 
Use the arrow keys to select More Information and press Enter to open the window. 

 

 

  

 

 

3. To print the information in the window, 
click the Print button. 

4. To add the part to your picklist, click the 
Add to Picklist button. 

5. When you finish viewing information, click 
the Close button to close the window. 
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Viewing Prices 
Use this procedure to view the price of an item in the parts list. 

 

1. Right-click a part entry. A Context menu opens. 

2. Select More Information from the menu. 

3. View the price. 

2

1

3 
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Toggling Price Displays On and Off 
If your data includes two types of pricing, PartsManager Pro allows you to temporarily 
hide one price in the More Information window. If, for example, you have dealer and 
retail prices, you may want to hide the dealer price while showing part information to a 
customer. To temporarily hide a price, do the following: 

1. With the More Information window displayed, right-click the price you want to hide. A 
context menu opens. 

 

2. Select Hide Price from the menu. 

3. The selected price, in this example the dealer price, disappears from the display. 

Note: The selected price is only hidden temporarily. All prices are displayed each 
time you open the More Information window. 

4. To redisplay the hidden price while the window is still open, click anywhere in the 
part information and select Refresh. 

Note: If you click outside the lined area that contains part information, the context 
menu will not open. 
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Viewing Supersession Information 
When  appears in front of an entry, supersession information is available for the part 
number. 

 

1. Click  to open the More Information window. 

 

2. To view information for other part numbers in the supersession history, select the 
check box to the right of the part number. Information for that part number will appear 
in the top portion of the window. 

3. To add a part to your picklist, select the check box to the right of the part number and 
click Add to Picklist. 

4. To print the information in the window, click the Print button. 

5. To close the window without adding a part to your picklist, click Close. 

6. To delete the superseded part from your picklist, highlight the part entry on the 
picklist and click Delete. 

Note: If you do not delete the superseded part, both parts will appear on your picklist. 
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Viewing User Notes 

When  appears in front of an entry, a user note is attached to the part number. 

 

Click  to open the View a Note window. The text of the note and the date it was 
created or last modified are displayed. The applicable figure number or page title is 
displayed in the title bar of the window. 

 

To print the notes listed in the window, click the Print button. 

Note: When multiple notes are listed, you can sort them by text or date by clicking on a 
column header. You can also resize the columns. 

Click the Close button when you finish viewing notes. 
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Viewing OEM Notes 
OEM notes are notes created by the manufacturer. Types of notes available vary 
according to manufacturer. Multiple OEM notes can be linked to a page or part number. 
You cannot modify or delete OEM notes. 

 

When  appears on a job tab, OEM 
notes are linked to a parts page. 

 

 When   appears in front of a part entry, 
OEM notes are linked to the part number. 

 

A part note can apply to all occurrences 
of a part number in all catalogs or to a 
single occurrence of a part number. 

 

To view OEM notes, click  to open the View a Note window. The window lists all notes 
linked to the parts page or part number. The applicable figure number or page title is 
displayed in the title bar of the window. 

The initial text of each note and the date it was created or modified are displayed. Click a 
note to display the complete text in the bottom portion of the window. 

 

To print the notes listed in the window, click the Print button. 

Note: When multiple notes are listed, you can sort them by text or date by clicking on a 
column header. You can also resize the columns. 

Click the Close button when you finish viewing notes. 
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Viewing Bulletins 
When  appears in front of an entry, a bulletin is available. 

  

To display the bulletin: 

1. Click  to open the Bulletins window. 

 

 

 

Note: When multiple bulletins are listed, you can sort them by date 
or description by clicking on a column header. You can also resize 
the columns. 

2. Click the bulletin description to display the bulletin. 

Bulletin description 
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If the bulletin opens in the PartsManager Pro main frame: 

 Right-click the bulletin to open a context menu and select 
a command to zoom, resize, or print the bulletin. 

 

 You can also double-click a bulletin to zoom in. 

 When you finish viewing the bulletin, click the Back command 
to return to the parts page from which you opened the bulletin. 

 Multi-page bulletins display paging buttons in the upper left corner 
of the bulletin display. Click the buttons to page forward and back. 

 

 

If the bulletin opens in a separate Adobe Reader window: 

 Use the Adobe Reader features to zoom, resize, page, and print. 

 When you finish viewing the bulletin, close the window to return 
to the parts page from which you opened the bulletin. 
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Making a “Where Used” Search from a Parts List 
You can search for all occurrences of a part number by right-clicking the number. For 
example, if the OEM-supplied information on a parts page showed an assembly as a line 
item and you wanted to identify the component parts, a “Where Used” search would 
locate all parts pages that include that part number. This additional information would 
help you identify the component parts. 

1. Right-click the part entry to highlight it and display a context menu. 

 

2. Select Where Used to display the Search dialog box. 

3. The search results window lists all occurrences of the part number. 

4. Double-click an entry to display the parts page. 
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Rearranging Information in a Parts List 
PartsManager Pro allows you to change the order in which part entries are listed and to 
resize and move columns. 

Note: If you modify the parts list and want to restore the original layout, right-click in the 
parts list to open a context menu. Then click Refresh. 

Sorting Information 

Change the order in which part entries are listed by doing the following: 

Click a column header. Entries are listed in order according to the information in that 
column. An upward-pointing triangle appears on the right side of the header and 
information is arranged in order from first to last. That is, entries that begin with letters 
are arranged in A-Z order and entries that begin with numbers are arranged in 1-9 order. 

If you click the column header again, a downward-pointing triangle appears on the right 
side of the header and information is arranged in order from last to first. That is, entries 
that begin with letters are arranged in Z-A order and entries that begin with numbers are 
arranged in 9-1 order. 

Resizing Columns 

Resize column widths by doing the following: 

1. Place the mouse pointer on the boundary between two column headers. The mouse 
pointer changes to . 

2. Hold down the left mouse button. 

3. Drag to the left or right. 

Moving Columns 

Rearrange the order in which columns appear by doing the following: 

1. Place the mouse pointer on a column header. 

2. Hold down the left mouse button and drag the header to the left. 

3. Stop dragging where you want to insert the column. The following example shows 
the Quantity column being inserted immediately in front of the Description column. A 
small green arrow indicates where the column will be inserted. 

 

4. Release the mouse button. The column is inserted at the arrow. In this example, the 
Quantity column is now located between the Part Number and Description columns. 
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Temporarily Wrapping Text in a Parts List 
Use this procedure to make the text in a parts list temporarily “wrap”, that is, adjust so 
that the text is viewable horizontally, eliminating the need to use the horizontal scroll bar. 

1. Right-click the parts list to open a context menu. 

2. Select Word Wrap from the menu. 

 

3. The parts text will adjust to fit the viewable area. 

Note: The Word Wrap menu option wraps text for the current parts list only. When you 
display a different parts page, you must select the option again to wrap text in that parts 
list. If you want text to wrap in all parts lists, select Settings from the Tools menu, click 
the Settings dialog box Page Settings tab, select the Word Wrap option, and click OK. 
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Printing Parts Pages 
When a parts page is displayed, you can print information by using the Print command 
from the File menu or the Print button. 

Using the Print Command from the File Menu 
Note: To use the Print command, a parts page must be displayed. 

 

With a parts page displayed, select Print from the File menu. The 
PartsManager Pro Printing dialog box is displayed. Select one or 
more options from the dialog box and click OK. 

You can print the parts diagram, parts list, page notes, part notes, 
and picklist by selecting any or all of the options at the same time. 

Exception: When you select Print This Section, you cannot select 
any other option at the same time. 

 

Print This Section prints all parts pages for 
the level immediately above the pages. For 
some OEMs, this might be a catalog.  

When you print a section, each parts page 
is displayed and printed in turn. The parts 
diagram is printed first, followed by the 
parts list. 

If you click Cancel to halt the printing of a 
section, the parts page currently displayed 
will finish printing before the process stops. 

Note: Print This Section is available only if 
supported by your OEM data. 
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Using the Parts Page Print Button 
You can also print parts diagrams, parts lists, page notes, and part notes by clicking the 
parts page Print button. 

 

 

 

 

1. Click the Print button . 

2. The Windows Print dialog box opens. 

3. Click the Print button in the dialog box. 

4. The parts diagram and parts list are printed 
with applicable page notes and/or part notes. 

Print button 
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7. Working with Picklists 
PartsManager Pro allows you to create a picklist to accumulate part numbers for a job. 
You can create one picklist for each job and use that picklist to prepare a quote for a 
customer or send the list of parts to your business system. 

 

 
1 Display the Main Page, Navigation window, or Search dialog box. 
2 Print the picklist. 
3 Display prices in the picklist. 
4 Create a DCS file. (See chapter 15) 
5 Type a part number and quantity. Click this button to add a part. 
6 Type a note to appear on the picklist. 
7 Create a quote for a customer. 
8 Delete highlighted parts from the picklist. 
9 Send the picklist to a business system. (See also chapter 13) 

10 Close the picklist. 
 

10 9 8 7 

6 

5 

4 3 2 1 
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Adding Parts to a Picklist from a Parts Diagram 
1. Place the mouse pointer directly on a callout. The pointer changes to a hand pointer. 

2. Right-click to display a context menu. 

3. Select Add to Picklist from the menu. 

 

Note: Add to Picklist is not available from the menu until you move the pointer to a 
callout and it changes to a hand pointer. 

4. The part is added to your picklist. 

5. Click  to view your picklist. 

Note: You can also add a part by placing the mouse pointer on a callout and double-clicking. 
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Adding Parts to a Picklist from a Parts List 
1. In the parts list, right-click a part entry to display a context menu. 

Note: To select multiple parts at a time, hold down the Ctrl key 
and click the entries in the parts list. The entries you select are 
highlighted. Then right-click the highlighted entries. 

2. Select Add to Picklist from the menu to add the part to your picklist. 

 

3. Click  to view your picklist. 

Note: You can also double-click a part entry to add the part to a picklist. 
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Adding Parts with Non-Numeric Quantities 
When a part shows a non-numeric quantity—“as required” (AR), for example—
PartsManager Pro prompts for a numeric quantity when you add the part to 
a picklist. 

1. Right-click the part and select Add to Picklist. 

 

2. The following dialog box is displayed. 

 

Note: A quantity of “1” appears by default. 

3. If you need a single part, click OK. If you need more than one part, 
type a different number before clicking OK. The part will be added 
to your picklist with the quantity you entered. 
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Adding Parts from the Picklist Dialog Box 
After creating a picklist, click  to open the Picklist dialog box and view 
your list. From this dialog box you can add parts and modify your picklist. 

1. Click . 

2. The Picklist dialog box is displayed. 

 

3. Select an OEM. 

4. Type a part number in the Part Number text box 

5. Type a quantity in the Quantity text box. 

6. Click  or press Enter. 

7. Repeat steps 4 through 6 for each part you need to add to the list. 
The parts appear in the picklist in the order in which they were added. 

8. If you type information in the Remarks text box, it will appear each 
time you display this picklist. 

9. To print the picklist, click . 
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Changing Quantities on a Picklist 
1. Click the quantity to highlight it. 

2. Type the new quantity. 

Deleting Parts from a Picklist 

To delete a part from a picklist: 

1. Click the part number you want to delete. The entry is highlighted. 

2. Click Delete. The part is removed from your picklist. 

To delete multiple parts from a picklist: 

1. Hold down the Ctrl key. 

2. Click each part number you want to delete. The entries are highlighted. 

3. Click Delete. The parts are removed from your picklist. 

Printing a Picklist 

To print directly from a picklst: 

1. Click the picklist Print button . 

2. The Windows Print dialog box opens. 

3. Click the Print button in the dialog box. 

4. The picklist is printed. 

To print a picklist when a parts page is displayed: 

1. Select Print from the File menu. 

2. The PartsManager Pro Printing dialog box is displayed. 

3. Select Print Picklist from the dialog box. 

4. Click OK. 
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Displaying More Information from a Picklist 
You can display additional information for a part number from a picklist by 
right-clicking the number. 

1. With the picklist displayed, right-click the part entry to highlight it and 
display a context menu. 

 

2. Select More Information to display the More Information window. 

Making a “Where Used” Search from a Picklist 
You can search for all occurrences of a part number from a picklist by right-clicking 
the number. 

1. With the picklist displayed, right-click the part entry to highlight it and display 
a context menu. 

 

2. Select Where Used to display the Search dialog box. 

3. The search results window lists all occurrences of the part number. 

4. Double-click an entry to display the parts page. 
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Rearranging Information in a Picklist 
PartsManager Pro allows you to change the order in which information is listed and 
resize columns. 

Sorting Information 

Change the order in which part entries are listed by doing the following: 

Click a column header. Entries are listed in order according to the information in that 
column. An upward-pointing triangle appears on the right side of the header and 
information is arranged in order from first to last. That is, entries that begin with letters 
are arranged in A-Z order and entries that begin with numbers are arranged in 1-9 order. 

If you click the column header again, a downward-pointing triangle appears on the right 
side of the header and information is arranged in order from last to first. That is, entries 
that begin with letters are arranged in Z-A order and entries that begin with numbers are 
arranged in 9-1 order. 

Resizing Columns 

Resize column widths by doing the following: 

1. Place the mouse pointer on the boundary between two 
column headers. The mouse pointer changes to . 

2. Hold down the left mouse button. 

3. Drag to the left or right. 
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8. Preparing a Quote for a Customer 
PartsManager Pro allows you to prepare a quote for a customer. You can import and 
modify a picklist or type information manually. Then print your quote and/or save it as an 
HTML file. 

Using the Print Quote Dialog Box 
With a picklist displayed, click Print Quote to display the Print Quote dialog box. 

 

Note: When the Print Quote dialog box is displayed, you cannot switch to other functions 
in the application. 
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Feature  How to Use 

PO  Type the customer’s purchase order number in the PO text box. 

Account  Type the customer’s account number in the Account text box. 

Customer Information  Type the name, contact, and address of the customer who will receive
the quote. 

Remarks  Type any special information you want to appear on the quote in the
Remarks text box. 

 
 Click the Price Escalator button and type a value to apply a discount 

or markup to all prices on the quote. See “Adjusting Prices on a Quote”
for details. 

Dealer Information  You only need to enter your dealership information one time. After you type 
this information, it will be applied automatically to each quote or eConnect
order you create. If any information changes, you can modify it at any time.
See “Entering Dealer Information” in chapter 1 for the procedure. 

Add Row  Click the Add Row button to add a row to the Parts List window. 

Delete Row  To delete one item from the Parts List window, click the entry to
highlight it. Then click the Delete Row button. To delete multiple items, 
hold down the Ctrl key and click each item you want to delete. Then 
click the Delete Row button. To delete all items, click the first item, 
hold down the Shift key, and scroll down to the last item and click it. 
Then click the Delete Row button. 

Parts List window  Displays the contents of a picklist or information you type. You can type 
more than parts information in this window. For example, you could
add a line and type the tax. 

Currency Code  Select the appropriate code for the currency you use. 

Shipping Method  Type the name of the shipping vendor or method (Best Way, for 
example) that will deliver the parts to your customer. 

Import from Picklist  Click the Import from Picklist button to import parts information from 
the current picklist into the Parts List window. You can modify this 
information if necessary. 

Print  Click the Print button to open a dialog box. Print a paper copy of the
quote and/or save the quote as a printable HTML file. 

Shipping/Handling  Type the shipping and handling cost. 

Labor Rate  Type the labor rate. 

Labor Hours  Type the number of hours. 

Total Cost  
 Click the Calculator button to display the total for the prices, shipping, 

and labor. Click the button to recalculate the total any time you add 
more parts or manually change one or more prices. You do not need to 
recalculate after applying a value with the Price Escalator button. You 
can also type the total cost manually. 

Close  Click the Close button to close the Print Quote dialog box. 
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Preparing a Quote 
The following procedure shows the basic steps in preparing a quote for a customer. All 
steps are not necessary for all situations. Use the dialog box features that are 
appropriate for each particular quote. 

1. Type the customer’s purchase order number in the PO text box. 

2. Type the customer’s account number in the Account text box. 

3. Type the customer’s business name and address and the name of the contact. 

4. Type any special information you want to appear on the quote in the Remarks text box. 

5. If you have not already entered your dealership information, click the Dealer 
Information button to open the Dealer Name dialog box. Then type information to 
identify you on the quote. Once you type your dealership information, it will be 
applied to each quote you create. 

6. Click the Import from Picklist button to import the current picklist into the Parts List 
window. Or Press the Add Row button to create a blank row and type parts 
information instead. 

7. If necessary, click the Add Row button to add rows for typing additional information 
such as additional parts, the amount of tax, etc. 

8. If necessary modify the information. You can modify any information displayed, 
whether you typed it or imported it from a picklist. 

9. Click the Price Escalator button  and apply a discount or markup to all prices on 
the quote. 

10. Type the shipping and handling charge. 

11. Type the labor rate and number of hours. 

12. Click the Calculator button  to total your charges. You can also manually type the 
total if you prefer. 

13. Click the Print button to open a dialog box. 

• To print your quote to fax to a customer, select Print Quote from the dialog box. 

• To save your quote as a printable HTML file for future reference or to make later 
modifications or additions, select Save Quote from the dialog box. 

• Click OK. 

14. When you finish, click the Print Quote dialog box Close button. 
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Entering Dealer Information 
You only need to enter your dealership information one time. After you type this 
information, it will be applied automatically to each quote or eConnect order you create. 
If any information changes, you can modify it at any time. See “Entering Dealer 
Information” in chapter 1 for the procedure. 

Importing a Picklist 
You can type parts and price information in the Parts List window or you can import 
information from the picklist for the current job. 

To import picklist information, click the Import from Picklist button. The part number, 
description, quantity, and price for the parts on the picklist are displayed in the Parts List 
window. The OEM is not displayed for each part. 

You can modify any information that appears in the Parts List window. Simply type over 
any information you need to change. If you change the quantity or price, the new 
subtotal is displayed in the Subtotal column. 

To add more entries below the last item, click the Add Row button to create a blank row. 
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Entering Parts and Price Information 
As an alternative to importing and modifying information from a picklist, you can type all 
the parts and price information that will appear in the quote. 

For each part that you want to include in the quote, type the part number, description, 
quantity, and price on a separate line in the Parts List window. 

You can also type other types of information in this area. For example, you might want to 
type the amount of tax. You do not need to type information in every column. 

When necessary, use the Add Row button to add rows for typing information. 

1. Click the Add Row button. A new row appears with zeros displayed in the Price and 
Subtotal columns. 

2. Click in the Part Number column, type a part number, and press the Tab key. 

3. Type a description and press the Tab key. 

4. Type a quantity and press the Tab key. 

5. Type a price and press the Tab key. The price in the Subtotal column will be the sum 
of the unit cost you typed times the quantity you typed. 

6. Use the Add Row button to add as many rows as necessary for additional 
information. 

7. If necessary, modify any information, including prices, whether you typed it or 
imported it from a picklist. 

Calculating the Total Cost 
Once you import and/or type information in the Parts List window, type your shipping and 
handling charge in the Shipping/Handling text box and type the labor rate and labor 
hours in their respective text boxes. 

To calculate the total cost, click the calculator button  that appears next to the Total 
Cost text box. 

Note: You must also click  when you change parts prices or other costs to update the 
total cost displayed. 

The total of the parts prices, shipping and handling, labor cost, and any other amounts 
you typed is displayed in the Total Cost text box. You can type changes to the total. 
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Adjusting Prices on a Quote 
PartsManager Pro provides two ways to adjust prices on a quote. 

 Manually change individual prices by typing over an existing amount. 

 Apply a discount or markup to all prices by using the Price Escalator button. 

Applying a Discount or Markup to All Prices 
1. Click the Price Escalator button . 

2. The Escalator dialog box is displayed. 

3. Type a multiplier, that is, the percentage of the current price that you want to appear 
on the quote. The application multiplies all prices on the quote by the value you type. 

Example: Apply a 10% discount (charge 90% 
of the current price). Type .90. 

 Example: Apply a 10% markup (charge 110% 
of the current price). Type 1.10. 

 

For additional examples, see “Examples of Discounts and Markups” on the next page. 

 
4. Click OK. The quote shows the discount or markup applied to all prices. 

Shipping/Handling and labor charges remain the same. The total adjusts automatically. 

5. Click the Print button on the quote. The Print Quote dialog box is displayed. 

 

To save the quote as a printable HTML file, select Save 
Quote and click OK. The adjusted prices and total are 
saved. See “Saving a Quote” on page 85 for details. 

To print the quote, select Print Quote and click OK. 
The adjusted prices and total appear on the printed 
quote. See “Printing a Quote” on page 86 for details. 

 

To save the quote as a printable HTML file and print it immediately, select Save 
Quote, click OK, and save the file. Then with the quote still open, click the Print 
button to redisplay the Print Quote dialog box, select Print Quote, and click OK. 
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Examples of Discounts and Markups 

Discount prices by 25%: 

In this example, you are effectively charging 75% of the original price. Type .75 or 0.75 
in the Escalator dialog box. For a $2.00 item, the application multiplies the original price 
($2.00) by 0.75. The adjusted price is $1.50. 

Mark up prices by 25%: 

In this example, you are effectively charging 125% of the original price. Type 1.25 in the 
Escalator dialog box. For a $2.00 item, the application multiplies the original price 
($2.00) by 1.25. The adjusted price is $2.50. 

Double prices 

In this example, you are effectively charging 200% of the original price. Type 2.00 or 2 in 
the Escalator dialog box. For a $2.00 item, the application multiplies the original price 
($2.00) by 2. The adjusted price is $4.00. 

Additional Information about Adjusting All Prices 
Discounts and markups are applied to prices only. They do not affect shipping/handling 
and labor charges. 

If you click the Add Row button to add an item to the quote after applying a discount or 
markup, the discount or markup will be cancelled and the original prices re-displayed. 

If you make a mistake before selecting a print option, close and reopen the quote to 
redisplay the original prices and total. 

If you make a mistake after selecting a print option, delete all items from the quote and 
re-import the picklist. 

Note: To delete all items, click the first item, hold down the Shift key, and scroll down to 
the last item and click it. Then click the Delete Row button. 
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Saving a Quote 
After entering the information in your quote, use this procedure to save your quote as a 
printable HTML file. You can save the file in a location of your choice and modify and/or 
print it. Or you can save it for future reference. 

1. Click the Print button on the quote. The Print Quote dialog box is displayed. 

2. Select Save Quote. 

 

3. Click OK. The Save As dialog box is displayed. 

4. Navigate to a folder or create a folder in which to save the file, type a file name, and 
click the Save button. 

5. Double-click the file name to open the quote. It will look similar to the following: 

 

Note: To save the quote as a printable HTML file and print it immediately, select Save 
Quote, click OK, and save the file. Then with the quote still open, click the Print button 
to redisplay the Print Quote dialog box, select Print Quote, and click OK. 
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Printing a Quote 
After entering the information in your quote, use this procedure to print a paper copy of 
your quote to fax to a customer. 

1. Click the Print button on the quote. The Print Quote dialog box is displayed. 

2. Select Print Quote. 

 

3. Click OK. The Windows Print dialog box is displayed. 

4. Click Print in the Windows Print dialog box to print the quote. The printed quote will 
look similar to the following: 

 

Note: To save the quote as a printable HTML file and print it immediately, select 
Save Quote, click OK, and save the file. Then with the quote still open, click the Print 
button to redisplay the Print Quote dialog box, select Print Quote, and click OK. 
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9. Creating and Viewing User Notes 
To supplement information from the OEM, you can create your own notes and link them 
to part numbers in a single catalog or all catalogs. 

Creating User Notes 
1. With the appropriate parts page displayed, right-click the part number to which you 

want to link a note. The part entry is highlighted and a context menu is displayed. 

 

2. Select Add a Note to display the Add a Note dialog box. The applicable figure 
number or page title is displayed in the title bar of the dialog box. 

 

3. Type your note in the text box. 
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4. Select an option. 

• To link your note to this part number only, select This Part Number. 

• To link your note to all occurrences of this part number in the current catalog, 
select This Part Number in this Catalog. 

• To link your note to the current parts page, select This Page in this Catalog. 

5. Click Add. 

• If you selected the first or second radio button,  precedes the part number(s) in 
the parts list. 

 

• If you selected the third radio button,  appears on the Job tab when you display 
that parts page. 
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Viewing User Notes 
When  appears in front of a part entry or on a job tab, a user note is available. Click  
to open the View a Note window. The text of the note and the date it was created or last 
modified are displayed. The applicable figure number or page title is displayed in the title 
bar of the window. 

 

Modifying User Notes 
1. Click the note. The text of the note is displayed in the large text box. 

2. Type your changes. 

3. Click Close. The modified note is attached to the part number. 

Note: Click the note again in the upper portion of the window to see your changes. 

Deleting User Notes 
1. Click the note. The note is highlighted. 

2. Click Delete. 

Printing User Notes 
To print the notes listed in the window, click the Print button. 
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10. Bookmarking Your Favorite Parts 
Pages 

When you use certain parts pages frequently, you can store them as “favorites”. The 
favorite folders and files you create are listed in the bottom portion of the Favorites menu 
so you can select them quickly and easily. 

 

When you select a favorite, PartsManager Pro immediately takes you to the parts page. 
The parts page is displayed in the current job. 

Clicking a folder opens a list of favorites saved in the folder. Clicking a favorite in the 
folder displays the corresponding parts page. 

Note: On a network, favorites are only available from the PC on which they were 
created. They cannot be accessed from other PCs on the network. 

Note: If you uninstall an OEM, any favorites saved for that OEM are grayed out and are 
no longer available. 
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Creating Favorites 
To bookmark a parts page as a favorite, display the page and 
select Add to Favorites from the Favorites menu. The Favorites  
dialog box will be displayed. 

 

 

Element  How to Use 

Title  The Title text box displays the title of the open 
parts page. You can click in the text box and type 
a new title. 

Create In  The Create In window lists favorite files and 
folders. 

OK  The OK button saves a favorite and closes the 
dialog box. 

Cancel  The Cancel button closes the dialog box without 
saving a favorite. 

New Folder  The New Folder button creates a new folder with 
a default name in the Create In window. You can 
change the default name by selecting Organize 
Favorites from the Favorites menu. 
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Example: Create a Favorite 

1. With the parts page displayed, select Add to Favorites from the Favorites 
menu to open the Favorites dialog box. 

Note: You can change the title of your favorite by clicking in the Title text 
box and typing a new title. 

2. Add your favorite to a folder. 

• To create a new folder for your favorite, click New Folder to display a 
new folder in the Create In window. The application assigns a default 
name to a new folder. You can change the name. 

• To add your favorite to an existing folder, click the folder to highlight it. 

3. Click OK to store your favorite in the folder. 
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Organizing Favorites 
Select Organize Favorites from the Favorites menu to open the  
Organize Favorites dialog box. 

 

 

Element  How to Use 

Create Folder  The Create Folder button allows you to create 
a new folder with a default name in the 
Favorites window. You can change the default 
name with the Rename button. 

Move to Folder  The Move to Folder button allows you to move 
the selected favorite to a different folder. 

Rename  The Rename button allows you to rename the 
selected folder. 

Delete  The Delete button deletes the selected folder. 

Favorites Window  The Favorites window lists favorites and 
favorite folders stored on the PC. 

Close  The Close button saves your changes and 
closes the Organize Favorites dialog box. 
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Moving a Favorite 

1. Click the favorite to highlight it. 

2. Click Move to Folder to open a dialog box. 

3. Click the destination folder to highlight it. 

4. Click OK. 

Renaming a Favorite or Folder 

1. Click the favorite or folder to highlight the name. 

2. Click Rename. 

3. Type the new name. 

4. Click Close. 

Deleting a Favorite or Folder 

1. Click the favorite or folder to highlight the name. 

2. Click Delete. 

3. Click Close. 
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11. Printing: Quick Reference 
PartsManager Pro allows you to print parts pages, picklists, page notes, part notes, 
sections, More Information displays, supersession information, quotes, and part 
compare information. This chapter provides a quick overview of how to print these types 
of information. For details, see the applicable chapter in this guide for each feature. 

Print Parts Pages 
When a parts page is displayed, you can print information by using the Print command 
from the File menu or the Print button. 

 
Using the File Menu 
“Print” Command 

Using the Parts Page 
“Print” Button 

 
1. Select Print from the File menu. 

2. The Printing dialog box opens. 

3. Select one or more options. 

4. Click OK. 

1. Click the Print button. 

2. The Windows Print dialog box opens. 

3. Click the Print button in the dialog box. 

4. The parts diagram, parts list, page notes, 
and part notes print. 

 

Print button 
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Print More Information and Supersession History 
Printing More Information Printing Supersession Information 

 
1. Right-click an entry in a parts list. 

2. Select More Information. 

3. The More Information window opens. 

4. Click the Print button. 

5. Information in the window prints. 

1. Click  in a parts list. 

2. The More Information window opens. 

3. Click the Print button. 

4. Information in the window prints. 

 

Print button
Print button 
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Print Page and Part Notes from the Notes Window 

 

 

1. Click the OEM note icon or user 
note icon in a parts list or on a 
parts page tab. 

2. The Notes window is displayed. 

3. Click the Print button. 

4. The notes listed in the window are 
printed. 

 

Print a Picklist 

 

 

 

 

1. Click the picklist Print button . 

2. The Windows Print dialog box opens. 

3. Click the Print button in the dialog box. 

4. The picklist is printed. 

 

 

Print button 

Print button 
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Print a Quote 
 

From the quote, click the Print 
button. The Print Quote dialog 
box opens. 

 

To save the quote as a 
printable HTML file, select 
Save Quote and click OK. 

To print the quote, select Print 
Quote and click OK. 

 
 

Print “Compare” Information 
After selecting the model specifications you want to compare, click Search to list the 
parts that are different. To print the part numbers and descriptions, click the Print button. 

 

 

Print button

Print button
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12. Shortcut Keys: Quick Reference 
Keyboard shortcuts are available for many PartsManager Pro features. This chapter 
provides shortcuts for some commonly used application functions. Use the keystrokes 
shown in the “Do this” column as follows: 

Keystrokes  What they mean 

“Alt+key1  key2”  Hold down the Alt key and press key1. Then press key2. 
“Alt+key1  key2”  [item]  Alt+key3  key4  Hold down the Alt key and press key1. Press key2. Next, highlight the 

item. Then hold down the Alt key and press key3. Finally, press key4. 
“Tab  [button]  Enter”  Press the Tab key as often as necessary to highlight the button. Then 

press the Enter key. 
“ Tab  [button]  Enter  [criteria]  Alt+key1”  Press the Tab key as often as necessary to highlight the button. Next, 

press the Enter key. Then enter your search criteria. Finally, hold down 
the Alt key and press key1. 

 

Changing Settings 

To  Do this 

Open the Settings dialog box.  Alt+T  S 

 

Working with Jobs 

To  Do this 

Create a new job.  Alt+N 
Open the Job Manager.  Alt+F  O  or  Alt+T  J 
Close the Job Manager.  Alt+C 
Open an existing job.  Alt+F  O  [job]  Alt+O  or  Alt+T  J  [job]  Alt+O 
Close the current job.  Alt+F  C 
Close all open jobs.  Alt+F  L 
Close the application.  Alt+F  E 
Rename a job.  Alt+F  O  [job]  Alt+M  or  Alt+T  J  [job]  Alt+M 
Delete a job.  Alt+F  O  [job]  Alt+D  or  Alt+T  J  [job]  Alt+D 

 

Searching for Information 

To  Do this 

Open the Search window.  Tab  Enter 
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Navigating to a Parts Page 

To  Do this 

Open the Navigation window.  Tab  Enter. 

 

Working with Parts Pages 

To  Do this 

Open the Print dialog box.  Alt+F  P 
Mark a parts page as a favorite.  Alt+A  A 
Organize your favorites.  Alt+A  O 

 

Working with Picklists 

To  Do this 

Open the Picklist dialog box.  Tab  Enter 
Delete a part from a picklist.  Tab  Enter  [part]  Alt+D 
Send a part to a business system 
(if configured). 

 Tab  Enter  [part]  Alt+S 

Close the Picklist dialog box.  Alt+C 

 

Working with Quotes (with Quote dialog box open) 

To  Do this 

Add a row.  Alt+A 
Delete a row.  Alt+D 
Close the Quote dialog box.  Alt+C 

 

Getting Help 

To  Do this 

Open the online Help.  Alt+H  H 
Open the user’s guide as a PDF.  Alt+H  U 
Start the interactive tutorial.  Alt+H  T 

 

Closing PartsManager Pro 

To  Do this 

Close the application.  Alt+F  E 
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13. Setting Up a Business System 
Interface (BSI) 

PartsManager Pro allows you to create, modify, and delete business system interface 
configurations. When you configure your business system interface, you can send parts 
information to your business system and receive return information in the More 
Information window. If you create more than one configuration, you can select the one 
you want to view and modify the values or delete the configuration entirely. See “Sample 
BSI Configurations” for examples of configurations that allow you to send single-OEM 
and multiple-OEM picklists via your BSI. 

Setting BSI Options 
Start setting up your business system interface from the PartsManager Pro Part 
Integration dialog box. Select Part Integration from the Tools menu. 

 

Depending on your business 
needs, you will either set up 
a connection to a business 
system or subscribe to 
eConnect. You will not use 
both. 
 
For information on setting up 
eConnect, see the next chapter.
 
Note: The WW Price Books 
tab is only available for 
OEMs whose price files are 
in a particular format. 
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Setting BSI Options 

Option  How to Set 

IP Address  Type the IP address of the branch server to which you are connecting. 

Timeout (ms)  Type the amount of time in milliseconds (ms) that 
PartsManager Pro should wait for a response when a request 
is submitted. For example, if you type 5000, PartsManager Pro 
will wait five seconds (5000 ms = 5 seconds). 

Port  Type the port number to which you are connecting. 

Send orders to this branch  Select this check box if you want to submit orders from 
PartsManager Pro to this branch. 

Note: If you do not select this check box, you will not be able 
to access this branch even if you create a configuration. 

Branch  Type the name of the branch. The name you type appears in 
the window in the upper left corner of the dialog box after you 
save the configuration. 

Customer Number  Type the number to use as a default customer number. 

Manufacturer Code  Type the code that identifies the manufacturer. 

Dataset  Select the manufacturer whose parts will be supplied by the branch. 

Currency Code  Type the currency code to be applied to prices. 

Delete  Select a branch from the window in the upper left corner of the 
dialog and click the Delete button to delete a BSI configuration. 

Save  Click the Save button when you finish entering information. 

Close  Click the Close button to close the Part Integration dialog box. 
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Creating a BSI Configuration 
1. Select Part Integration from the Tools menu. 

The Part Integration dialog box is displayed. 

2. Select New from the window in the upper left corner. 

3. Enter appropriate information in the text boxes and 
list boxes. 

4. Click Save. 

5. Click Close. 

Modifying a BSI Configuration 
1. Select Part Integration from the Tools menu. 

The Part Integration dialog box is displayed. 

2. Select the appropriate configuration from the window 
in the upper left corner. The values you entered for 
that configuration are displayed in the text boxes and 
list boxes. 

3. Enter new information in the applicable text boxes 
and list boxes. 

4. Click Save. 

5. Click Close. 

Deleting a BSI Configuration 
1. Select Part Integration from the Tools menu. 

The Part Integration dialog box is displayed. 

2. Select the appropriate configuration from the window 
in the upper left corner. 

3. Click Delete. 

4. Click Close. 
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Sample BSI Configurations 
These examples show how to set up BSI configurations for sending single-OEM or 
marketing unit or multiple-OEM or marking unit picklists to one or more business 
systems. How you create your BSI configurations will depend on your particular 
business system environment. 

Configuring the BSI for a Single-OEM/Marketing Unit  

1. Select Part Integration from the PartsManager Pro Tools menu. The Part 
Integration dialog box is displayed. 

2. Select New from the window in the upper left corner. 

3. Type an IP address, timeout value (in milliseconds), and port in the appropriate text 
boxes. Select an OEM or marketing unit from the OEM list box. 

Note: You must always enter at least these four values when creating a BSI configuration. 

4. If appropriate, type a branch name, customer number, and manufacturer code. If you 
want to send orders to this branch, select the “Send orders to this branch” check box. 

5. Click Save. 

6. The name you typed in the Branch text box will appear in the window in the upper left corner 
of the dialog box. When you click the branch name, the values you entered are displayed. 
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7. Create a picklist. See “Working with Picklists” for the procedure. 

 

8. Click the Picklist dialog box Send button. 

Note: A message indicates that the picklist with data from a 
single OEM/marketing unit was sent to a single business system. 

9. Click OK to close the message box. 
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Configuring the BSI for Multiple OEMs/Marketing Units with the Same Manufacturer Code 

1. Select Part Integration from the PartsManager Pro Tools menu. The Part 
Integration dialog box is displayed. 

2. Select New from the window in the upper left corner. 

3. Type an IP address, timeout value (in milliseconds), port, and manufacturer code in 
the appropriate text boxes. Select an OEM or marketing unit from the OEM list box. 

Note: You must always enter at least these five values when creating a multi-
OEM/marketing unit BSI configuration. 

4. When appropriate, type a branch name and customer number. If you want to send 
orders to this branch, select the “Send orders to this branch” check box. 

5. Click Save. 

6. The name you typed in the Branch text box will appear in the window in the upper left 
corner of the dialog box. When you click the branch name, the values you entered 
are displayed. 

 

Note: In this example, branch 08 uses the same manufacturer code (C1) as the 03 
branch created in the previous example. This indicates that picklists containing data 
from these two companies will be sent to the same business system. 
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7. Create a picklist using data from both OEMs/marketing units. See “Working with Picklists” 
for the procedure. 

 

8. Click the Picklist dialog box Send button. 

Note: A message indicates that the picklist with data from two OEMs/marketing units 
was sent to a single business system. In this case, these two OEMs/marketing units 
were configured for the same manufacturer code. 

9. Click OK to close the message box. 
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Configuring the BSI for Multiple OEMs/Marketing Units with Different Manufacturer Codes 

1. Select Part Integration from the PartsManager Pro Tools menu. The Part 
Integration dialog box is displayed. 

2. Select New from the window in the upper left corner. 

3. Type an IP address, timeout value (in milliseconds), port, and manufacturer code in 
the appropriate text boxes. Select an OEM or marketing unit from the OEM list box. 

Note: You must always enter at least these five values when creating a multi-
OEM/marketing unit BSI configuration. 

4. When appropriate, type a branch name and customer number. If you want to send 
orders to this branch, select the “Send orders to this branch” check box. 

5. Click Save. 

6. The name you typed in the Branch text box will appear in the window in the upper left 
corner of the dialog box. When you click the branch name, the values you entered 
are displayed. 

 

Note: In this example, branch 10 uses a manufacturer code (D2) different from the 
codes created for the 03 and 08 branches in the previous examples. This indicates 
that picklists containing data from the 03 and 08 branches will be sent to one business 
system, while data from 10 will be sent to a different business system. 
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7. Create a picklist using data from all three OEMs/marketing units. See “Working with 
Picklists” for the procedure. 

 

8. Click the Picklist dialog box Send button. 

Note: A message indicates that the picklist with data from three OEMs/marketing 
units was sent to two business systems. In this case, ABC Equipment Company 
data was sent to one business system, while data for MNH Equipment Company 
and Tech Company (configured for the same manufacturer code) was sent to a 
different business system. 

9. Click OK to close the message box. 



112 PartsManager Pro User’s Guide 15022006-3.4 

14. Setting Up and Using eConnect 
If you have a connection to a dealer management system (DMS) that does not support 
ordering parts electronically from your vendor(s), you probably phone or fax your orders. 
By subscribing to eConnect, you can use PartsManager Pro to view real-time inventory 
information and order parts electronically from one or more trade partners (vendors). 

Depending on your business needs, you will either set up a connection to a business 
system or subscribe to electronic ordering using eConnect. You will not use both. 

Important: You must have an Internet connection to use eConnect with PartsManager Pro. 

Signing In 
Start setting up eConnect from the PartsManager Pro Part Integration dialog box. 

1. Select Part Integration from the Tools menu. Then click the eConnect tab. 

 

2. Click the Subscribe button. 
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3. The Login page is displayed. 

 

4. Sign in to eConnect. 

• If you have already created a user name and password, type your user name 
and password, click the Sign In button, and skip to “Adding a Subscription” later 
in this chapter. 

• If you are a new user, click the Sign Up Now button. 
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The Company Information page is displayed. 

 

5. Type a user name in the Username text box. 

6. Type a password in the Password text box. 

7. Type the password again in the Verify Password text box. 

Note: Write down the user name and password that you create. 

8. Enter your dealership information. 

Note: This information is for your eConnect subscription only. It may differ from the 
dealership information that you entered in PartsManager Pro. 
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You must enter information in each field that displays a red asterisk (*). If you previously 
entered your dealership information, it will already be displayed in these fields. For example: 

 

9. Click the Submit button. 

Note: Everyone at your dealership can use the user name and password you create. 
It is not necessary to create a different user name and password for each PC 
running PartsManager Pro with eConnect. 

Next you need to add a subscription. Proceed to the next section, “Adding a 
Subscription”, to learn how. 
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Adding a Subscription 
When you enter a user ID and password to log on to eConnect, the Current Subscriptions 
page is displayed. From this page you can start the process of adding a subscription. 
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To add a subscription: 

1. From the Current Subscriptions page, click the Add New Subscription button. The 
Choose Trade Partner page is displayed. 

 

“Trade partners” are the manufacturers and distributors with whom you transact 
business. It is another term for “vendors” or “suppliers”. The Choose Trade partner 
page lists all available trade partners alphabetically by name. Each name appears as 
a clickable link below a logo.  

2. If necessary, scroll down the page until you find the trade partner you want. 
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3. Click the link to display the Choose Service page. 

 

As used with eConnect, “services” refers to two primary ways of doing business with 
eConnect: 

Dealer Xpress: Enables electronic ordering using the Dealer Xpress Web 
application. 

Integrated DMS: Enables eConnect for PartsManager Pro. 

4. Click the Integrated DMS link. 
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The Add Service page is displayed. 

 

5. Type the vendor code provided by your DMS in the Vendor Code text box. 

Important: This code must match the vendor code in your DMS. 

6. Type a dealer number in the Dealer Number text box. 

Note: As used with eConnect, “Dealer Number” is the same as “Account Number”. 

7. Click the Save button. 
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The Current Subscriptions page is again displayed. The page now shows your trade 
partner and the service type to which you subscribed, your vendor code (a code you 
create to designate the trade partner), your account number (same as your dealer 
number), and additional information that applies to your subscription(s). 

 

Note: The column headers on the Current Subscriptions page are Help links. Click a 
link to display a brief description of how to enter information in that column. The 
column headers shown on the sample page above are examples only. 

Note: Clicking the Edit button displays the Edit Service page is displayed. From this 
page you can edit an existing subscription. 

8. Click the Logout link on the left side of the screen. 

You are now ready to set up eConnect in PartsManager Pro. See the next section, 
“Setting Up eConnect in PartsManager Pro”. 
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Setting Up eConnect in PartsManager Pro 
The previous section showed how to subscribe to eConnect and set up your trade 
partners (vendors). This section shows how your subscriptions allow you to set up 
eConnect in PartsManager Pro. 

Start by selecting Part Integration from the Tools menu. The Part Integration dialog 
box is displayed. Click the eConnect tab. 

 

Depending on your business 
needs, you will either set up 
a connection to a business 
system or subscribe to 
eConnect. You will not use 
both. 
 
For information on setting up 
a connection to a business 
system, see the previous 
chapter. 
 
Note: The WW Price Books 
tab is only available for 
OEMs whose price files are 
in a particular format. 
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Setting eConnect Options 

Option  How to Set 

Subscribe  Click the Subscribe button to subscribe to services and add trade 
partners (vendors). 

Dealer Information  You only need to enter your dealership information one time. 
After you type this information, it will be applied automatically 
to each quote or eConnect order you create. If any information 
changes, you can modify it at any time. See “Entering Dealer 
Information” in chapter 1 for the procedure. 

Dataset  Currently, a purchase order can include parts from one 
manufacturer only. Select the manufacturer from this list box. 

Account Number  The first time you select an OEM on the eConnect tab, this 
field will be empty. Once you type and save the number, it will 
display automatically. 

Note: As used with eConnect, “Account Number” is the same 
as “Dealer Number”. 

Vendor Code  The first time you select an OEM on the eConnect tab, this field will 
be empty. Once you type and save the code, it will display 
automatically. 

Note: This code must match the vendor code in your DMS. 

Vendor Name  The first time you select an OEM on the eConnect tab, this field will 
be empty. Once you type and save the name, it will display 
automatically. 

Orders Sent to Vendor  This check box activates and deactivates eConnect. Select this 
check box to enable eConnect. De-select the check box to 
disable eConnect. 

Save  Click the Save button when you finish entering information. 

Close  Click the Close button after typing the account number, 
vendor code, and vendor name for the selected OEM. 
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Entering Ordering Account Information 
1. From the eConnect tab in the Part Integration dialog box, select an OEM from the 

OEM list box. 

2. Type the account number, vendor code, and vendor name. 

3. Select the Orders Sent to Vendor check box. 

 

4. Click the Close button. 

Note: The first time you select an OEM on the eConnect tab, these fields will be 
empty. After you type the information in each field and click the Save button, the 
information will be displayed each time you select the OEM. 

You are now ready to view real-time inventory information from your trade partner(s) 
and place orders electronically with PartsManager Pro. 
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Viewing Vendors’ On-Hand Quantities and Prices 
Once you set up services and trade partners, the More Information window in 
PartsManager Pro displays additional information. 

1. With a parts page displayed in PartsManager Pro, right-click a part number in the 
parts list. A context menu opens. 

2. Select More Information from the menu. 

3. The More Information window is displayed. If necessary, scroll down through the 
window until you find the information you need. 

When the window shows “Returned From: Electronic Dealer Network“, real-time 
information from the trade partner is being displayed. 

 

To print the information in the window, click the Print button. 
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Sending Picklists to Your Trade Partners 
Once you set up services and trade partners (vendors), clicking the Picklist 
dialog box Send button in PartsManager Pro sends the list to your trade partner, 
allowing you to order the listed parts. 

Important: If you need to prepare a quote for the customer, create the quote 
before you send the picklist as an order to your trade partner. When an order 
is submitted, the parts are cleared from the picklist and you cannot create a 
quote from that list. 

1. Click the Picklist button  to display your picklist. For example: 

 

2. Click the Send button. The Order window is displayed. 
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The Order window displays your customer information, the default shipping method, 
and the parts from your picklist, including current prices from your trade partner 
(vendor). 

Note: “Customer” information, as used here, indicates your dealer information 
because you are the “customer” to whom the vendor will ship the parts. 

 

3. Type the purchase order number in the text box at the top of the window. 

Note: You must type the purchase order number. If the purchase order box is empty 
when you try to submit an order, a message will remind you to type the number. 

4. When necessary, select a different shipping method from the list box. 

5. To print the order before submitting it, click the Print button. 

6. Click the Send Order button. The message “PO: 8000-0030-083 sent successfully” 
is displayed. 

7. Click OK to close the message box. 
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The parts are cleared from your picklist and the Order window is updated with 
additional information such as quantity ordered. 

 

8. To print the updated information, click the Print button. 

9. To close the Order window, click the Close button. 

Note: Once you close the Order window, you cannot reopen it for viewing or printing. 
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15. Creating a DCS File 
Use this procedure to create a file for a dealer communication system (DCS) from a 
picklist. 

1. Create a picklist in PartsManager Pro. For example: 

 

 

 

Click this button to 
create a DCS file. 

Click this button 
to display prices. 
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2. Click the DCS button. The DCS File Generation dialog box opens. 

 

3. Select the DCS format. 

4. Click the Browse button and navigate to the folder to which you want to write the file. 

5. Type a name for the file in the File Name box. 

Note: After you generate your first DCS file, the format and most recently generated 
folder and file name are displayed each you open this dialog box. 

6. Select the field delimiter for the file. For example, to create a tab-delimited file, select 
[TAB]. 

7. Type your dealer code, select the order type, and type the order number. 

Note: Dealer Code, Order Type, and Order Number boxes are not available for all OEMs. 
 

8. Click OK to generate the DCS file. The message “File Created” will be displayed. 
Click OK to close the message. 

Note: A tab-delimited text file will look similar to the following: 

 

9. In your DCS, browse to the file you created. 
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16. ISO 4217 Currency Codes 
When you display pricing in PartsManager Pro, each value is followed by a three-letter 
code. For example, “$150.00” is displayed as “150.00 USD”. This code comes from ISO 
standard ISO 4217:1995, which contains codes for currencies worldwide. The following 
table lists all current codes. 

Code Currency Code Currency 
ADP Andorran Peseta CNY  Yuan Renminbi  

AED UAE Dirham COP  Colombian Peso  

AFA  Afghani CRC  Costa Rican Colon  

ALL Lek  CUP  Cuban Peso  

AMD Armenian Dram  CVE  Cape Verde Escudo  

ANG Netherlands Antillean Guilder  CYP  Cyprus Pound  

AON New Kwanza  CZK  Czech Koruna  

AOR Kwanza Reajustado  DEM  Deutsche Mark  

ARS Argentine Peso  DJF  Djibouti Franc  

ATS Shilling  DKK  Danish Krone  

AUD Australian Dollar  DOP  Dominican Peso  

AWG Aruban Guilder  DZD Algerian Dinar  

AZM Azerbaijanian Manat  ECS  Sucre  

BAD Dinar  ECV  Unidad de Valor Constante (UVC)  

BBD Barbados Dollar  EEK  Kroon  

BDT Taka  EGP  Egyptian Pound  

BEF Belgian Franc  ESP  Spanish Peseta  

BGL Lev  ETB  Ethiopian Birr  

BHD Bahraini Dinar  EUR  Euro  

BIF Burundi Franc  FIM  Markka  

BMD Bermudian Dollar  FJD  Fiji Dollar  

BND Brunei Dollar  FKP  Falkland Islands Pound  

BOB Boliviano  FRF  French Franc  

BOV MVDol  GBP  Pound Sterling  

BRL Brazilian Real  GEL  Lari  

BSD Bahamian Dollar  GHC  Cedi  

BTN Ngultrum GIP  Gibraltar Pound  

BWP Pula GMD  Dalasi  

BYB Belarussian Ruble  GNF  Guinea Franc  

BZD Belize Dollar  GRD  Drachma  

CAD Candian Dollar  GTQ  Quetzal  

CHF  Swiss Franc  GWP  Guinea-Bissau Peso  

CLF  Unidades de Formento  GYD  Guyana Dollar  

CLP  Chilean Peso  HKD  Hong Kong Dollar  
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Code Currency Code Currency 
HNL  Lempira  MWK  Kwacha  

HRK  Kuna  MXN  Mexican Nuevo Peso  

HTG  Gourde  MYR  Malaysian Ringgit  

HUF  Forint  MZM  Metical  

IDR  Rupiah  NAD  Namibia Dollar  

IEP  Irish Pound  NGN  Naira  

ILS  Shekel  NIO  Cordoba Oro  

INR  Indian Rupee  NLG  Netherlands Guilder  

IQD  Iraqi Dinar  NOK  Norwegian Krone  

IRR  Iranian Rial  NPR  Nepalese Rupee  

ISK  Iceland Krona  NZD  New Zealand Dollar  

ITL  Italian Lira  OMR  Rial Omani  

JMD  Jamaican Dollar  PAB  Balboa  

JOD  Jordanian Dinar  PEN  Nuevo Sol  

JPY  Yen  PGK  Kina  

KES  Kenyan Shilling  PHP  Philippine Peso  

KGS  Som  PKR  Pakistan Rupee  

KHR  Riel  PLN  Zloty  

KMF  Comoro Franc  PLZ  Zloty  

KPW  North Korean Won  PTE  Portuguese Escudo  

KRW  Won  PYG  Guarani  

KWD  Kuwaiti Dinar  QAR  Qatari Rial  

KYD  Cayman Islands Dollar  ROL  Leu  

KZT  Tenge  RUR  Russian Ruble  

LAK  Kip  RWF  Rwanda Franc  

LBP  Lebanese Pound  SAR  Saudi Riyal  

LKR  Sri Lanka Rupee  SBD  Solomon Islands Dollar  

LRD  Liberian Dollar  SCR  Seychelles Rupee  

LSL  Loti  SDD  Sudanese Dinar  

LTL  Lithuanian Litas  SEK  Swedish Krona  

LUF  Luxembourg Franc  SGD  Singapore Dollar  

LVL  Latvian Lats  SHP  St. Helena Pound  

LYD  Libyan Dinar  SIT  Tolar  

MAD  Moroccan Dirham  SKK  Slovak Koruna  

MDL  Moldovan Leu  SLL  Leone  

MGF  Malagasy Franc  SOS  Somali Shilling  

MKD  Denar  SRG  Surinam Guilder  

MMK  Kyat  STD  Dobra  

MNT  Tugrik  SVC  El Salvador Colon  

MOP Pataca  SYP  Syrian Pound  

MRO  Ouguiya  SZL  Lilangeni  

MTL  Maltese Lira  THB  Baht  

MUR  Mauritius Rupee  TJR  Tajik Ruble  

MVR  Rufiyaa  TMM  Manat  
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Code Currency Code Currency 
TND  Tunisian Dollar  VND  Dong  

TOP  Pa’anga  VUV  Vatu  

TPE  Timor Escudo  WST  Tala  

TRL  Turkish Lira  XAF  CFA Franc BEAC  

TTD  Trinidad and Tobago Dollar  XCD  East Caribbean Dollar  

TWD  New Taiwan Dollar  XOF  CFA Franc BCEAO  

TZS  Tanzanian Shilling  XPF  CFP Franc  

UAG  Hryvna  YER  Yemeni Rial  

UAK  Karbovanets  YUM  New Dinar  

UGX  Uganda Shilling  ZAL  Financial Rand  

USD  US Dollar  ZAR  Rand  

UYU  Peso Uruguayo  ZMK  Kwacha  

UZS  Uzbekistan Sum  ZRN  New Zaire  

VEB  Bolivar  ZWD  Zimbabwe Dollar 
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17. Glossary 
This glossary defines terms used in this user’s guide. 

application 

A computer program used for a particular kind of work, such as parts 
information retrieval or word processing. This term is often used 
interchangeably with “program.” 

BSI 

An acronym for business system interface. PartsManager Pro allows 
you set up a BSI connection to your business system. 

button 

A graphic image that can be clicked to initiate an action. A button may 
include an icon or a text label to indicate what it does. For example, 
the Search button  includes a magnifying glass icon, indicating that 
the button allows you to make a search. 

catalog notes 

Notes provided by the OEM at the catalog-level of information. When 
catalog notes are available, the  icon appears on a folder in the 
Navigation window or navigation pane of the Search dialog box to 
indicate that catalog notes are available. View catalog notes by right-
clicking an entry. 

check box 

 

A small box that allows you to turn an option on or off by clicking it. 
When a check box is selected, a check mark appears in the box. 

click 

To press and release the left mouse button quickly. 

combination box (combo box) 

A combination of a list box and text box that includes both a scrollable 
list and a field in which you can type text. As you type text, items from 
the list that match the text scroll into view. 
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command 

A word or phrase on a pull-down menu that you click to carry out an action. 

compare 

A feature that allows you to compare two model specifications by 
listing the parts that need to be added and/or deleted to change one 
model specification into the other. 

configure 

To create or change a setup. For example, PartsManager Pro allows 
you to configure a connection to your business system. 

context menu 

A pop-up menu that provides access to frequently-used commands 
when you right-click an item. For example, when you right-click a 
parts diagram, a context menu lists commands that allow you to 
zoom, resize, refresh, print, add notes, and add parts to a picklist. 
Also called a floating menu. 

cursor 

The position indicator on the screen showing where you can enter text. 

dataset 

A dataset is a collection of related information consisting of the 
database, parts diagrams (TIFF files), hotspot (.hsp) files, and service 
documents (PDF files) that make up OEM data content. A dataset can 
include product lines, catalogs, sections, parts pages (parts diagrams 
and associated parts text), service documents, and bulletins. You can 
publish multiple datasets, one per CD. 

default 

A predefined setting used by an application when no other option is specified. 

desktop 

The workspace on a computer screen, usually referring to the “main 
screen” in Windows, which provides access to programs and folders 
via clickable icons. 
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dialog box 

A window on the computer screen that allows you to type or select 
information, set options, or carry out commands. 

double-click 

To quickly click the left mouse button two times. 

drag 

To move an item on the screen by selecting the item and then 
pressing and holding down the left mouse button while moving the 
mouse. For example, you can move a window to another location on 
the screen by dragging its title bar. You can also define an area of a 
parts diagram to zoom in on by holding down the Shift key while 
holding down the left mouse button and moving the mouse. 

eConnect 

The name of ProQuest’s Web-based program for subscribing to 
services and setting up trade partners (vendors) to enable electronic 
ordering from PartsManager Pro. 

favorite 

A frequently-accessed parts page that you bookmark for future reference. 

highlight 

When you select a menu command or an entry in a list, it is 
highlighted to indicate that it has been selected. A highlight usually 
appears as a dark blue band across the entry, and the selected text 
changes from black to white within the band. 

icon 

A graphical representation of an element in an application or 
operating system. For example, clicking the New Job icon  allows 
you to create a new job. 

job 

Another name for a transaction, a collection of related tasks you 
perform to process a parts order. 

Job Manager 

A dialog box that allows you to open, rename, and delete jobs. 
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keyword 

A word you type in a text box in the Search window’s Keyword tab to 
search for parts information. A keyword may be a model or other term 
defined by your OEM. 

list box 

A box that displays the current selection and allows you to click a 
small arrow on the right side of the box to open the complete list of 
selections. The list box shown above allows you to select a language 
for the application. 

More Information 

A window that displays additional information for a part when you 
right-click a part entry. If you subscribe to services and set up trade 
partners (vendors) using ProQuest’s eConnect Web site, this window 
can also display such real-time inventory information as on-hand 
quantities and current prices from a vendor. 

mouse pointer 

The small symbol on the screen that moves with the mouse. Within 
text, the mouse pointer appears as a cursor, but it changes shape 
depending on its location on the screen. For example: An arrow , a 
hand , or a cross . 

navigate, navigation 

To navigate is to follow a path to a particular destination. 
PartsManager Pro provides a structure for your OEM data that allows 
you to navigate through the data to a specific parts page. This 
structure consists of an organized hierarchy which may include 
datasets, product lines, models, catalogs, sections, parts pages, and 
service documents. The available navigation levels depend on your 
OEM data. PartsManager Pro provides a Navigation window and a 
Search dialog box navigation pane. 

OEM 

An acronym for original equipment manufacturer. 

OEM notes 

Notes provided by the original equipment manufacturer. You cannot 
delete OEM notes. OEM notes are identified by the  icon in front of 
a parts list entry or on a job tab. 
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pane 

A defined segment of a window or dialog box. For example, the 
Keyword tab of the Search dialog box includes a navigation pane. 

parts diagram 

The illustration portion of a parts page. 

parts list 

The parts text associated with a parts diagram on a parts page. Parts 
are generally listed by reference number, part number, description, 
quantity, and remarks. You can also view bulletins, user notes, OEM 
notes, and supersession information by clicking an icon. 

PartsManager Pro 

A parts and service data retrieval application developed by ProQuest. 

parts page 

An electronic catalog “page” consisting of a parts diagram and parts list. 

Picklist 

A dialog box you use to accumulate parts for a job. You can select 
parts for a picklist from parts diagrams and parts lists, and you can 
type part numbers and quantities directly in the dialog box. You can 
send the contents of a picklist to a business system or order the parts 
from a vendor, depending on how you set up PartsManager Pro. 

pictorial index 

An image-based index to parts information in the Navigation window. 
You click images to display levels of information. Clicking a catalog 
opens an additional pane which displays the primary pictorial index to 
that catalog. Clicking an image opens sectional index. Clicking a 
section image callout displays a parts page. 

pull-down menu 

A list of available commands in an application window. Menu names 
appear in the menu bar near the top of the window. You open a menu 
by clicking the menu name. 
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quote 

A list of parts, with quantities, prices, and additional charges for a 
customer. You can import a picklist and add additional parts, customer 
information, dealer information, a purchase order number, and shipping 
and labor charges. You can then print the quote for the customer. 

radio buttons 

A group of buttons in a dialog box of which only one can be selected 
at a time. You select a radio button by clicking it. 

remarks 

Additional comments or notes that appear in a parts list. 

right-click 

To click an item by using the right mouse button. You can display a 
context menu by right-clicking an item. For example, right-clicking a 
parts list entry opens a menu that allows you to add the part to a 
picklist, display additional information for the part, make a “where 
used” search, add a user note, or refresh the list. 

scroll 

To move through text or graphics (up, down, left, or right) to see 
information that does not fit on the screen. Scroll bars with arrows at 
the sides and bottom of windows help you scroll through information. 

services 

“Services” refers to two primary ways of doing business with eConnect 
and PartsManager Pro: Dealer Xpress, which allows electronic ordering 
of parts, and Integrated DMS, which enables electronic ordering for 
PartsManager Pro. When you subscribe to Integrated DMS and set up 
your trade partner(s), you are ready to conduct business using 
eConnect and PartsManager Pro. 

sort, sorting 

To rearrange information according to some criteria. For example, you 
can sort the results of a parts search by description, parts page, etc. 
to make it easier to find the specific information you need. 
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supersession 

Information for a part that has been replaced by one or more other 
parts. When supersession information is available, the  icon appears 
in front of a part entry. Clicking the icon displays the information. 

text box 

A field in a dialog box in which you type information. The text box may 
be blank or may contain text when the dialog box opens. 

trade partners 

As used with eConnect, “Trade partners” are the manufacturers and 
distributors with whom you transact business. It is another term for 
“vendors” or “suppliers”. 

user notes 

Notes created by users to supplement information provided by the 
OEM. You can modify and delete user notes. User notes are identified 
by the  icon in front of a parts list entry or on a job tab. 

where used 

A type of search that lists all occurrences of a part number in all 
catalogs. 

wildcard 

A wildcard is a special character that represents any other character 
or group of characters in a search. PartsManager Pro uses the 
asterisk (*) for the wildcard character. The asterisk (*) can represent 
zero, one, or multiple characters in a part number or description. You 
can type wildcards in your search criteria for part number searches 
and part description searches. 

window 

A rectangular area on the screen in which you view information. You 
can open, close, resize, and move windows and open several 
windows at a time. 
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